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2R TH
2.1 %t

1) #¥A{ER%: WIN7/WINIO 64-bit OS

2) IDE: Eclipse IDE for GNU ARM & RISC-V C/C++ Developers
3) XM YiiFHE: arm-none-eabi-gee

4) #wPF 1L H: GNU MCU Eclipse build tools

5) GDB fi45#%: J-Link GDB Server

6) Hik#s: J-Link VO/V10

2.2 T

1) F &M N32H760xIx7-STB V1.0
2) JLink T#i#& V9 BiLL L
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» F# xpack-arm-none-eabi-gce-10.2.1-1.1-win32-x64.zip SCAF
Hbhk:  https:/github.com/xpack-dev-tools/arm-none-eabi-gcc-xpack/tags

www.nationstech.com

1Jj 5] https://github.com/xpack-dev-tools/arm-none-eabi-gcc-xpack/releases/ ] 6 3% & H A A B A ) ARM 38 X
Y B

3.2 Build T E %3

> F# xPack Windows Build Tools v4.2.1-2-W32-X64.zip 3
Hibk: https:/github.com/xpack-dev-tools/windows-build-tools-xpack/releases/tag/v4.2.1-2/

1Jj I7) https://xpack.github.io/windows-build-tools/releases/F] % £ N #A F A I w3 T E .

3.3 Eclipse IDE 3%

3.3.1 JDK %%

> F# the jdk-8u202-windows-x64.exe 1

Eclipse % & 12 17 76 Java 3%, FT LLTE %2 %% Eclipse 2 Bl 7 B 5 % %% JDK . 1 http:/www.o
racle.com/technetwork/java/javase/downloads/java-archive-javase8-2177648.html ] % # N & A E A ) JDK T K.
ARICHESE jdk-8u202-windows-x64.exe NEIF A, 4% the jdk-8u202-windows-x64.exe A TERUG.

KA 22 $TJF dos fn AT 10, B java -version MR JDK 275 IEAfZ2%% . W IDK CLIEHh 2%,
CIECE ) PEr s

wn SR X +

Microsoft Windows [fZ4 10.0.26100.4349]
(c) Microsoft Corporation, {RE8FRERFI.

C:\Users\' >java —version

java version "1.8.0_202"

Java(TM) SE Runtime Environment (build 1.8.8_202-b8s)

Java HotSpot(TM) 6u-Bit Server VM (build 25.202-b88, mixed mode)

ER: AN, IEREA A B NI

3.3.2 Eclipse IDE for GNU ARM C/C++ Developers %3

> T Download the eclipse-embedcpp-2021-03-R-win32-x86_64.zip 3

Hiik: https:/www. eclipse.org/downloads/download.php?file=/technology/epp/downloads/release/2021-0 3/R/eclipse-

4 R AR A7FR 2 5 Nations Technologies Inc.
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embedcpp-2021-03-R-win32-x86 64.zip.

ilAl https:/eclipse-embed-cdt.github.io/packages/releases/ 1] % % T # A [ Bk & 1 Eclipse IDE.

3.4 &3 JLink TR
> T JLINK &8/, v7.50 R A

https://www.segger.com/downloads/jlink/#-LinkSoftware AndDocumentationPack

[0 J-Link Software and Documentation Pack

_ Vers'“" —

J-Link Software and Documentation pack V7 50 v Windows
£
o AT G T S R [2021-07-01] 64-bit Installer & 32-bit Installer
= Can be downloaded and used free of charge by any owner of a SEGGER J-Link, J-Trace or
Flasher model. Linux
. 35;::‘;;:::;?;:;: may be available on all J-Link / J-Trace / Flasher models. & 64-bit DEB Installer & 32_bit DEB Installer
- Release Notes & 64-bit RPM Installer & 32-bit RPM Installer
» More information & 64-bit TGZ Archive & 32-bit TGZ Archive
Linux ARM
& 64-bit DEB Installer & 32-bit DEB Installer
& 64-bit TGZ Archive & 32-bit TGZ Archive
macOS

& 64-bit Apple Silicon Installer
& 64-bit Intel Silicon Installer

3.5 I B Xk

LAY JLink 2 J5 75 2L W) JLink FESMBBATA RS AN TA, DMEE T, R IR E R 85002
BRESE R (Glink T ENIN Nations 0 /.72

3.6 JLink &M

PR JLink FFEE %%

HERELF PC %ﬂj Link YHIXAS, BRI RN, FH;

2. THF cmd.exe AT L, HEN Jlink %235 H 3%“C:\Program Files (x86)\SEGGER\JLink V750" F, HiA
“JLink.exe”’;

=V

SEGGER J-Link Commander V7.50 (Compiled Jul 1 2021 17:43:13)
DLL version V7.50, compiled Jul 1 2021 17:41:53

Connecting to J-Link wvia USB...0.K.

Firmware: J-Link V9 compiled May 7 2021 16:26:12
Hardware version: V9.U@

S/N: 59417u52

License(s): RDI, GDB, FlashDL, FlashBP, JFlash
VTref=3.291V

Type "connect" to establish a target connection, '?' for help
J-Link>|

5 R AR A7FR 2 5 Nations Technologies Inc.
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B E#oR PC IEHE JLink W iAAs 5] -
SRIEMRAE SRR IRE A . “connect”, “N32H760XIX7”, “SWD”, “4000”, WIRATHKRIERD), WEER T
Ml L ILink FEBASF BT DUE 6 7 .
Type "connect" to establish a target connection, '?' for help
J-Link>connect
Please specify device / core. <Default>: N32H760XIX7
Type '?' for selection dialog
Device>
Please specify target interface:
J) JTAG (Default)
S) sWD
T) cJTAG
TIF>s
Specify target interface speed [kHz]. <Default>: UBBB kHz
Speed>
Device "N32HT76BXIXT" selected.

Connecting to target via SWD

InitTarget() start

FhF kAR hRdhhdhdhhRdhdbhddbdbhdbhddhdbhhbbibhhhhhhd

J-Link script: NationsTech Cortex-M7 J-Link script
dhkdhddhhdhhdhdbhRdhddhddbdbhdbhdhhbhbbibhhdhhhhd
InitTarget() end

Found SW-DP with ID ©x2BAO14T7

DPIDR: ©x2BA®1U4T7

AP map detection skipped. Manually configured AP map found.
AP[®]: AHB-AP (IDR: Not set)

AP[1]: AHB-AP (IDR: Not set)

AP[2]: AHB-AP (IDR: Not set)

AP[8]: Core found

AP[8]: AHB-AP ROM base: ©xE@EFFO00

CPUID register: OxU11FC272. Implementer code: @xi1l (ARM)
Found Cortex-M7 rlp2, Little endian.

FPUnit: 8 code (BP) slots and ® literal slots

CoreSight components:

ROMTbL[A] @ EGBFFEEA

ROMTbL[@][0]: E@EOEEee, CID: B1O5EEED, PID: B@EBBEOC SCS-M7
ROMTbL[@][1]: Eeeeleee, CID: B1O5EEED, PID: ©@EBBEO2 DWT
ROMTbL[@][2]: E@0O2000, CID: B1O5SEEED, PID: G@OBBEOE FPB-M7
ROMTb1[@][3]: Eeeeeeee, CID: B1O5EEED, PID: @@EBBEOL ITM
Cache: Separate I- and D-cache.

I-Cache L1: 32 KiB, 512 Sets, 32 Bytes/Line, 2-Way

D-Cache L1: 32 KiB, 256 Sets, 32 Bytes/Line, U-Way
SetupTarget() start

SetupTarget() end

Cortex-M7 identified.
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4.1 FrE Workspace
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Eclipse #HA B NG EAE, Toi e, BHBEAE eclipse U2 R eclipse.exe K5 3l Eclipse, A2 5
W N ERTR.

— Eclipse IDE Launcher

X
Select a directory as workspace

Eclipse IDE uses the workspace directory to store its preferences and development artifacts.

9 5
Workspace: | |2 ‘eclipse-workbase| w Browse...

[ Use this as the default and do not ask again

» Recent Workspaces

WK, EFEARM IS, Al workspace. A7 Launch. ¥ EIKASIREAR R, H#E YOS 5
Al LI BRI /e F A welcome BT AT F #f workbench FEIFRIE A 32 7LHT o

S eclipse-workspace - Eclipse IDE S ]
File Edit Source Refactor Navigate Search Project Run Window Help
i ‘ v v@j-m-gv@vag;vovgvgng.,- B:i%y o\
~ Bl kac Gy D | Q s
{5 Project Explorer 22 2 al =8 Eox > ]
There are no projects in your There is 1o, active editor
workspace. that provides an outline.
To add a project:
[E¥] in a directory containing
existing code
[ Create a new C or C++ project
[ Create a project..
[2] Problems 2 £ Tasks B Console [C] Properties o =
0 items
Description Resource Path Location Type
0 items selected % A
7 R AR A7FR 2 5 Nations Technologies Inc.
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4.2 % E Build TEKZ

7 Eclipse % 3% 612, ##57 Eclipse toolchain 3. # T H 2225 Ui I N #01 ARM 42 X 4 1%4E, Build T
B Ja B AL S RN, an T B PR

www.nationstech.com

= " » eclipse > eclipse_toolchain > £ eclipse_toolchain 3%
Tl H= = 55
=R EEE Sl
xpack-arm-none-eabi-gce-10.2.1-1.1 2025/6/9 11:34 prg ==
xpack-windows-build-tools-4.2.1-2 2025/6/9 10:13 g L=

1) $THF Winodow->Preferences 1%

= eclipse-workspace - Eclipse IDE

File Edit Source Refactor Mavigate Search Project Run [Window| Help

e T - el [ E A New Window s
- - } - - | = Editor 4
. = Appearance L
5 Project Explorer ©3 B
5% 97 3 Show View r
. . i 3
There are no projects in your Perspective
workspace. Mavigatian r
To add a project:
i ) Preferences
Create a new Makefile project

|l [E9 ina directory containing
existing code

@ Create a new C or C++ project

4 Create a project..
Ex Import projects...

2) % $& MCU->Global  Build Tools Path , ¥ B 4 /& Build L. H i & :
${eclipse_home}\eclipse_toolchain\xpack-windows-build-tools-4.2.1-2\bin, X H 75 £ 0 B AN BEAE

8 A AR A3 7 FR A 5] Nations Technologies Inc.
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= Preferences O X
type filter text | Global Build Tools Path =l v 8
Changelog " The locations where various Eclipse Embedded CDT build tools are installed. Unless defined marn
Docker workspaces.
Help

F)uild toals folder: | ${eclipse_home}\eclipse_toolchain\xpack-windows-build-tools-4.2.1-2\bin I

Install/Update
Library Hover
v MCU
Global Arm Toolchains Paths
| Global Build Tools Path |

Global OpenCOCD Path
Global pyQCD Path
Global QEMU Path

P I R YT W N (Y P S R PR I

< >

@. By 223 @ |Apply and Closel Cancel

43 REX X HELARE

% MCU->Global Arm Toolchains Path, 1% B 4> J5 Arm Toolchains . E % £ .
${eclipse_home}\eclipse toolchain\xpack-arm-none-eabi-gcc-10.2.1-1.1\bin

— - — T
type filter text Global Arm Toolchains Paths Sro- i
Changelog m Configure the locations where various GNU Arm toolchains are installed. The values are stored within Eclipse. Unless redefined

» Docker B e e el G dl e ol e s
» Help Default toolchain: |xPack GNU Arm Embedded GCC -

. Install/Update
> Library Hover
4 MY [Tuclchain folder:  ${eclipse_homefeclipse_toclchain\xpack-arm-none-eabi-gee-10.2.1-1.1\bin I Browse... *Pack...
.
Global Build Tools Patl
Global OpenQCD Path
Global pyOCD Path
Global QEMU Path
Global RISC-V Toolchains Paths
Global SEGGER J-Link Path
Workspace Arm Toolchains Paths
Workspace Build Tools Path
Warkspace OpenOCD Path
Workspace pyOCD Path
Workspace QEMU Path
Workspace RISC-V Toolchains Paths
Workspace SEGGER J-Link Path

Toolchain name:  xPack GNU Arm Embedded GCC

m

o - i [Restore Defaults| [ Apply |
@' @ 1247 @ [App\y and Close]l[ Cancel ]
9 A AR A3 7 FR A 5] Nations Technologies Inc.
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4.4 ¥t B SEGGER J-Link Path

1% #% MCU->Global SEGGER J-Link Path, % & 4:/5 SEGGER J-Link T H#84%, iX BikFEA ML HE, A4
HH #8424 C:\Program Files\SEGGER\JLink75

type

Y
= Preferences

filter text

WO W

W

A

W

> General
v CfC++

Appearance
Autotools

Build

CMake

Code Analysis
Code Style

Core Build Toaolcha
Debug

Dacker Container
Editor

File Types

Indexer

Language Mapping
MCU Packages

Mesan

a X

Global SEGGER J-Link Path S v 8
Configure the location where SEGGER J-Link is installed. The values are stored within
Eclipse. Unless redefined more specifically, they are used for all projects in all
workspaces.

After installing SEGGER updates, restart Eclipse for the defaults to be re-evaluated and
use the Restore Defaults button to configure the new location.

Executable: JLinkGDBServerCLexe

Folder:

C\Program Files\SEGGERYJLink75 Browse...

> New CfC++ Project
» Profiling
» Property Pages Set
Task Tans Restore Defaults Apply
X Bt 5E A% Eclipse IDE {4 #BHCE -
10 R AR A7FR 2 5 Nations Technologies Inc.
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5. LEEFEZKiLE

SDK ¥ H E R I BHT A SDK, 4HTEH v1.0.0, 7ESEHEAS E AU N B LLE R Eclipse FF R 5 .

5.1 HE T

1.¥TJF Eclipse, fE“File->New” | iJi£ 412 C/C++ Project, #%EF#: C Managed Build.

= eclipse-workspace - Eclipse IDE
Edit Source Refactor Navigate Search Project Run Window Help
New Alt+Shift+N » | &2 Makefile Project with Existing Code
Open File...
(, Open Projects from File System... [ Project..

2 ’ 'IJ Y 3 = L [ Create a new C or C++ project i
Seeentbies [c5] Convert to a C/C++ Autotools Project
Close Editor Ctrl+W | [&] Convertto a C/C++ Project (Adds C/C++ Natu
Close All Editors Cirl+Shift+W | &% Source Folder
Save Culss |&3 Folder
; . ¢/ Source File
Save As... = «

Save Al Ctrl+Shift+s | "feader b
Revert [ File from Template
& Class
Move... .
Rename... F2 | Bample
&1 Refresh F5 | Other..
Convert Line Delimiters To >
Print... Cirl+P
g  Import.
3 Export.
Properties Alt+Enter
Switch Workspace »
Restart
Exit S = | =S
2.3 C Managed Build
= Mew C/C++ Project — | T [
Templates for New C/C++ Project
O et -
CMake T ac Project build using the CDT's managed build
Make system.
Meson
’ C++ Managed Build =
\{CE * A C++ Project build using the CDT's managed build
spstent.
CMake Project |
A CMake project with a Hello World executable to get
started.
Empty or Existing CMake Project
Create 3 CMake project with no files. Can be used to
create one over existing content.
4 - — — | +

11
E R ARG ERAT NSING TECHNOLOGIES INC.
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3.\ Projectname, FCE TFERAY, A7 J7 (8@ UCK TR E] Workspace H3K Fo 4iiiBieFA ARM Cross
GCC

www.nsingtech.com

Project name: F'rnjecti

[ Use default location

Location: ary.1.1.00projects\n32h76x_EVAL\examples\GPIO\LedBlink\Eclipse Browse...

Choose file system: default

Project type: Toolchains:

GMU Autotools Arm Cross GCC
Executable Cross GCC

Empty Project RISC-V Cross GCC
Hello World ANSI C Project

Hello World Arm C Project

Hello Waorld RISC-V C Project

ADUCM36x C/C++ Project

Hello World Arm Cortex-M C/C++ Project
Freescale Processor Expert C/C++ Project
Freescale Kinetis Koo C/C++ Project

¢ ¢ ¢ @ ¢ e EE

4. % Eclipse IDE CIE#fi% & T ARM Toolchains Path, 1X B2 H 31k 5. # Eclipse IDE KX E ARM
Toolchains Path, 4 A]7EiX B %&£ %] ARM Toolchains 44X #5452, SR )G iy “Finish” BI5ER% T TREAIEE S .

— O
GNU Arm Cross Toolchain E—

Select the toolchain and configure path

Toolchain name: |xPack GNU Arm Embedded GCC (arm-none-eabi-gec) v
Toolchain path:  ${eclipse_homelieclipse toolchain\xpack-arm-none-eabi-gcc-10.2.1-1.14bin Browse...
12
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1. At LFE4, 1%+ new->Folder
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la -bc proje o ey o U .
2 ) Ind New » | Project...
i@ In}
2 L{_ﬂ Go Into ® Fle
b df‘ Open in New Window L File from Template
B showln Altsshiftsw » 5 Folder
i i 3] =%
Show in Local Terminal @ Class
[E Copy Ctrl+C | [n] Header File
Paste Ctrl+V | [¢] Source File
K Delete Delete | &% Source Folder
» o .
Sotrce @ C/C++ Project
Move... = 5
Maye [cs] Convert to a C/C++ Project (Adds C/C++ Nature)
Rename... F2
™ Example...
iy Import.
= Oale bl o D1

2. 553 5T STARTUP, BSP, CMSIS, DOC, FWIB, LD, SVD, USER KT R {32

Enter or select the parent folder:

Project

=
b =% Project

Folder name: |BSP

== Advanced

() [= Use default location
0 (7 Folder is not located in the file system (Virtual Folder)
() g Link to alternate location (Linked Folder)

Browse... Variables...

13
E R ARG ERAT NSING TECHNOLOGIES INC.
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3. Aiili BSP, &% Import 135, T ) BSP U A [FEE, HAb SO 195 A7 A0, X Bt
MMPEZ AN,

File system [
7
Import resources from the local file system. L‘j ..f"‘

From directory: | DALMM\eclipse-warkbase\Mationstech.N32H76x_78x_Library.1 V| Browse...

@ (= src @ (¢ delay.c
@ [clogc
Filter Types... Select All Deselect All
Into folder: Project/BSP Browse...
Options

] Overwrite existing resources without warning

[C] Create top-level folder
== Advanced

iCreate links in workspacei

B Create virtual folders

B Create link locations relative to: PROJECT_LOC ~

@' < Back Mext = Cancel

14
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4 FNFERSE, AT R E R

v (2= Project (in Eclipse)

3 :jf Binaries
» [ Includes
» (B STARTUP

e
> [g) delay.c
> [ log.c
v G CMSIS
> g} system_n32h76x_78x.c
» = Debug
v g DOC
5 readme.txt
> gy FWIB
v g LD
g n32h76x_78x_flash.ld
v = SVD
= N32H76x.svd

=l

“ [ USER

> g main.c
> g n32h76x_78x_it.c

5.3 TEARCE
5.3.1 kR

Hiii TAE, 1&$E TIZJEME Properties JEIFTH, 7E“C/C++ Build->Settings->Tool Settings->Target Processor”
BCE AT ARHE B AR N A%, 1EFE cortex-m3 . cortex-md. cortex-m0 % cortex-m7. 7EAS 1, EFF cortex-

m7, WK BN
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— Properties for Project

type filter text

Settings

» Resource
Builders
v C/C++ Build |
Build Variables
Environment
Logging
|
Tool Chain Editor
v C/C++ General
» Code Analysis
Documentation
File Types
Formatter
Indexer
Language Mapping
Paths and Symbols
Preprocessor Inclu
Profiling Categorie:
Linux Tools Path
> MCU
Project Matures
Project References
Run/Debug Settings
Task Repository
Task Tags
» Validation

Configuration: Debug [ Active ]

& Tool Settings ¥ Toolchains

B Devices

[ Container Settings # Build Steps

(¥ Target Processor
) (22 Optimization
(22 Warnings
(2 Debugging
w 8 GMU Arm Cross Assembler
(% Preprocessor
(% Includes
2 Warnings
(& Miscellansous
w [ GNU Arm Cross C Compiler
@ Preprocessar
22 Includes
# Optimization
=2 Warnings
# Miscellaneous
w B3 GMU Arm Cross C Linker
% General

(% Libraries
# Miscellaneous

W -

w 8 GMU Arm Cross Create Flash Image

Arm family (-mcpu) [cortex-m7

Architecture (-march) Toolchain default
Instruction set Thumb (-mthumb)

[ Thumb interwork (-mthumb-interwork)

Endianness Toolchain default
Float ABI Toolchain default
FPU Type Toolchain default

Unaligned access Toolchain default

[ TrustZone (-mcmse)
Generic (-mcpu=generic)
Toolchain default
Toolchain default
Toolchain default

Enabled (+simd)

5.3.2 fith S HK AL E

#£C/C++ Build->Settings->Tool Settings->Optimization” e B, Wi%-00.-01.
-02., -03., -Os. -Ofast. -Og.

— Properties for Project

type filter text

» Resource
Builders
Build Variables
Environment
Tool Chain Editor
v C/C++ General
> Code Analysis
Documentation
File Types
Formatter
Indexer
Language Mapping
Paths and Symbaols

I} [ |

Settings

Target Processor
(1= Optinizaton]
Warnings
(#2 Debugging
~ 83 GNU Arm Cross Assembler
(2 Preprocessor
(# Includes
(#2 Warnings
(# Miscellaneous
~ 3 GNU Arm Cross C Compiler
@ Preprocessor
(2 Includes
(# Optimization
(2 Warnings
(# Miscellaneous
w I8 GMNU Arm Cross C Linker

Optimization Level None (-00)

B Message length (-fmessage-length=0)

B 'char' is signed (-fsigned-char)

B Function sections (-ffunction-sections)

B Data sections (-fdata-sections)

[CJNe common unitialized (-fno-common)

[l Do not inline functions (-fno-inline-functions)

[_] Assume freestanding environment (-ffreestanding)

[_| Disable builtin (-fno-builtin)

[_l Position independent cade (-fPIC)

[l Single precision constants (-fsingle-precision-constant)
[ Link-time optimizer (-flto)

[_| Disable loop invariant move (-fno-move-loop-invariants)

Ctther optimization flags

Build Artifact
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5.3.3 GNU Arm Cross C Compiler ZHiCE

{E“C/C++ Build->Settings->Tool Settings->GNU Arm Cross C Compiler” &I H L & Cross C

S PRI o

A, 7EPreprocessor->Defined symbols(-D)” i%& i 71 ¥% Ji CORE_CM7, N32H76x Fll
USE_STDPERIPH DRIVER i %%

= Properties for Project

type filter text Settings
» Resource (# Target Processor [[] Do not search system directories (-nostdinc)
Builders - L —
- &2 Optimization [l Preprocess only (-E)
| c/C++ Build | - .
(22 Warnings

Defined symbols (-0}

Build Variables

) (# Debugging
Environment

~ B GNU Arm Cross Assembler
Logaging ® p N32H76x
(£ Freprocessor USE_STDPERIPH_DRIVER
g (# Includes
Tool Chain Editor
w CfC++ General

(# Warnings
(2 Miscellaneous
) w B3 GNU Arm Cross C Compiler
Documentation ey
i =2 Preprocessor
File Types Iﬂ'l_!?—,
22 Tncludes

Formatter

> Code Analysis

p (# Optimization
Indexer . (# Warnings
Language Mapping

Dogel s Coppenlns]

7t includes->Include paths™i% W H1 78 I AR 75 09k SR8 A% . AEAEI s :

"${ProjDirPath}/../../../../../../firmware/n32h76x_78x std periph driver/inc"
"${ProjDirPath}/../../../../../../firmware/CMSIS/core"
"${ProjDirPath}/../../../../../../firmware/CMSIS/device"
"${ProjDirPath}/../../../../bsp/inc"

"${ProjDirPath}/../inc"

(2 Miscellaneous

5.3.4 GNU Arm Cross C Linker Bt B

£ “C/C++ Build->Settings->Tool Settings->GNU Arm Cross C Linker”fic & Cross C ##£1E . 7F“General
->Script files” BT HIN:  "${workspace loc:/${ProjName}/LD/n32h76x_78x flash.Id} "
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& Prop ec
type filter text Settings

> Relsuurce (2 Target Processar Script files (-T)
Builders

 Optimizati
C/C++ Build & Optlr‘rf\zatlon “${workspace loc/${ProjName}/LD/n32h76x 78x flash.Id}”
@ Warnings
Build Vaniables

Enviranment

(£ Debugging
v B3 GNU Arm Cross Assembler

Lolm @ Preprocessor
oo = ditor 2 Warnings
v CjC++ G | et ;
JC++ 9"9“'. 2 Miscellaneous
» Code Analysis

~ [ GNU Arm Cross C Compiler

Documentation
(2 Preprocessor

File Types (2 Includes
Formatter # Optimization
Indexer

. 2 Warnings
Language Mappings ™

(# Miscellanecus
Paths and Symbals

~ LGN Arm Cro Linker
Prepr‘ocessor In:!ude (8 General
Profiling Categories .
TBraries

Linux Tools Path
» MCU
Project Natures

2 Miscellaneous
~ 3 GNU Arm Cross Create Flash Image

1 2 General
Project Re‘eremfes ~ 3 GNU Arm Cross Print Size
Run/Debug Settings (& General
Task Repository
Task Tags [[JDo not use standard start files (-nostartfiles) ]
» Validation [[JDo not use default libraries (-nodefaultlibs)

WikiText ibs (- i
I—'Remove unused sections (-Xlinker --gc-sections)

(] Print removed sections (-Xlinker --print-gc-sections)

[CJ Omit all symbol information (-s)

1d JA A T3 15 UREE RS, St S8 O AT AT ST AT B N A7 . fE I Id BIAS R AT & B A5t 1) FLASH
J SRAM K/ Ko 2 & (N AP BL B

H: FEHHZE “Do not use standard start files” o

1E Miscellaneous iE Wi, “A)i%k Use newlib-nano & Do not use syscalls. (A EALARAL KN

—] Properties for Project

type filter text Settings
» Resource (8 Target Processor Linker flags (-Xlinker [option])
Builders (& Optimization
2 Warnings
Build Variables (= Debugging
Environment ~ 8 GNU Arm Cross Assembler
Logaing (% Preprocessor
# Includes
Tool Chain Editor (£ Warnings
~ CJC++ General # Miscellaneous
> Code Analysis ~ &3 GNU Arm Cross C Compiler
Documentation (% Preprocessor Other objects
File Types # Includes
Formatter # Optimization
Indexer & Warnings
Language Mappings 5 Wi an
Paths and Symbols ~
Preprocessor Include General
Profiling Categories &2 Liheari
Linux Tools Path (& Miscellaneous
> MCU ~ Fate Flash Image . . .
Project Natures (2 General Generate map "${BuildArtifactFileBaseName}.map”
Project References ~ ) GNU Arm Cross Print Size [[JCross reference (-Xlinker --cref)
Run/Debug Settings % General (] Print link map (-Xlinker --print-map)
Task Repository I @ Use newlib-nano (--specs=nano.specs) ]
Taslk T?QS [(JUse float with nano printf (-u _printf_float)
» Validation [_] Use float with nano scanf (-u _scanf float)
WikiText

I @ Do not use syscalls (--specs=nosys.specs) ]
[CIVerbose (-v)

Other linker flags
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5.3.5 BEEBEARK bin X4

#£4C/C++ Build->Settings-> Build Steps” i 8N4, A5k bin/hex A+,
ABIHERIN: arm-none-eabi-objcopy -O binary "Project.elf” "Project.bin"; arm-none-eabi- objdump -D

www.nsingtech.com

"Project.elf" > "Project.dump"

S Properties for Project

type filter text Settings
» Resource .
Builders 3 Tool Settings &3 Toolchains ‘B Devices [0 Container Settings # Build Steps Build Artifact Binary Parsers
w|C/C++ Build Pre-build steps
Build Variables Command:

Environment |

Logging
Description:
Tool Chain Editor |

~ C/C++ General

> Code Analysis Past-build steps
Documentation E:ommand: :
File Types Iarm—none—eabi—objcopy -0 binary "Project.elf” "Project.bin”; arm-none-eabi- abjdump -D "Projectelf” = "Project.dump” I
Formatter —
Description:
Indexer

Language Mappings |
Paths and Symbols

Prepracessor Include

Profiling Categories
Linux Tools Path
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i%#% Project->Build Project P4 il TRE, BRI IFEHI 75 AL ORAE 9T TREF e, SNk 2 E—ik
P TR BSUS, N TR IER, 155G clean TA2/5 75 build. 4miF5eii)a, WA R elfy hex /% bin 3L

G

Fle Edit Source Refactor MNavigate Search Project Run Window Help
R B-H=E SRR AR R R AT =l
- Fl e e m Q s H
3 De.. FoPr.. T O  [& mainc i = 8 w=v i ®%B STE =
2% 7 8 65 ~eturn none o = | B
c tact (in Ecliose) /
™ & Project (in Eclipse) = int main(void)
> f;? Binaries
> [l Includes /* Initialize system clock */
RCC_SetSysClkToMode®();
> @' STARTUR /* RCC ccnfigu'aticn ———————————————————————
v [ BSP RCC_Configuration();
3 delay.c /* LOG configuration -----------------—--—-——--
@ | v log init();
> g loge /* GPIO configuration ----------------""---
¥ [y CMSIS GPIO_Configuration();
» system_n32h76x 78
L6t sy = = while (1)
» = Debug I
~ @y DOC GPIO SetBits(LED1_PORT,LEDL_PIN);
[ readme.td systick_delay ms(508);
Awie GPI0_ResetBits(LED1_PORT,LED1_PIN);
> Em systick_delay ms(588);
v imlD h
5 n32h76x_78x flashl: }
w = SVD
El N32H76x.svd B Console & (2] Problems (2 Executables [ Debugger Console 4 Search T
- USER -
%@ , XG5 EEEE B -
N Man.c ) CDT Build Console [Project]
> [ n32h76x_78x_it.c = e
arm-none-eabi-ocbjcopy -0 ihex "Project.elf" "Project.hex"
Finished building: Project.hex
Invoking: GHU Arm Cross Print Size
arm-nene-eabi-size --format=berkeley "Project.elf”
text data bss dec hex filename
6576 8 8736 15328 3bd8 Project.elf
Finished building: Project.siz
89:88:53 Build Finished. ® errors, ® warnings. (tock 6s.146ms)
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TEEHAH, S Run—>Debug Configurations, it A\ Debug FCE 5 M. {1/ J-Link GDBServerCL {E4
GDB Server, i} GCC T E4EH ) GDB 1. EA{E N GDB Client. *{ili GDB SEGGER J-Link Debugging, #7
7%= J-Link [{fC & %50,

7.1 Main &I F

{E Main TR, EFEMET L, —MBSEIDIAET TR T elf 3CF. WREA, wblbd
Browse, Fausin elf X4

= Debug Configurations O X

www.nsingtech.com

Create, manage, and run configurations

G = x| = Mame: Project Debug

| E| Main| %% Debugger | b+ Startup | 5 Source| [C] Comman| &, SVD Path
€] ¢/C++ Application
[€] C/C++ Attach to Appli
[E] C/C++ Container Laun Project Browse...
[E] C/C++ Pastmortem Di| | C/C++ Application:
[£] C/C++ Remote Applic
Cit C/C++ Unit
[c] GDB Hardware Debug Variables... Search Project.. Browse...

Project:

Debug\Project.elf ]

~ [£] GDB OpenOCD Debug Build (if required) befare launching
€] New_configuration

[&] GDB PyOCD Debuggir Build Configuration: | Select Automatically v
E GDB QEMU Debuggin (C) Enable auto build () Disable auto build

~ [T] GDB SEGGER J-Link Dy
[E Project Debug ]
i Launch Group

© Use workspace settings Configure Workspace Settings...

7.2 Debugger &=

7t Debugger IR, HE HA5E 85 Device name, A #1245 N32H760xIx7

HAEFE T Eclipse RGN O IEFARL E J-Link #8545, 1X B B 2000 2R 2 A IERARC & , th 7] 7E Executable
path #2, %" J-Link GDBServerCL H44 %} 4%

ER: HENSRS, EMER J-Link K30 02015 R
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‘= Debug Configurations [m] *

Create, manage, and run configurations

OFE®BE x' B Y - Mame: Project Debug

| Main |#§ Debugger] b Starlup| 7] Source| i Qommon| =, SVD Path|
[T] C/C++ Application J-Link GDB Server Setup -
[E] C/C++ Attach to Applicatio B start the J-Link GDB server locally [[J Connect to running target
[E] €/C++ Container Launcher E bl h [I: P Files\SEGGER\JLink73\JLinkGDBS CL B ] Variak
(5] C/C++ Postmortem Debug xecutable path: M\Program Files, SJLink7 5% Lin erverCLexe rOWse... aria
[E] C/C++ Remote Application Actual executable: C:\Program Files\SEGGERYJLink75')LinkGDBServerCL.exe
Cii C/C++ Unit (to change it use the global or workspace preferences pages or the project properties
[£] GDB Hardware Debugging , .
. Dlevice name: MN32H760xIx7 Supported device r
v [£] GDB OpenOCD Debugging
[&] New_configuration Endianness: O Little (O Big
[£] GDB PyOCD Debugging Connection: O UsE O1p (USB serial or IP name/address)
[£] GDB QEMU Debugging Interface: Oswp  (OJTAG
v GDB SEGGER J-Link Debu
EE Project Debug 8 Initial speed: O Auto () Adaptive © Fixed 1000 kHz
& Launch Group GDB paort: 2331
SWO port: 2332 B Verify downloads [ Initialize registers on
Telnet port: 2333 B local host only [ Silent
Log file: Brov
Other options: -singlerun -strict -timeout 0 -noqui v
Revert Apply

Filter matched 14 of 14 items

7.3 SVD Path E&TF

£ SVD Path e, EHE HAREF P 1 SVD 3.

s Debug Configurations O

Create, manage, and run configurations

G [ o B x| B Y~ Name: Project Debug

| Main |:%§ Debugger | B+ Startup B> Source|§ Common | 7 SVD Path
[E] C/C++ Application SVD file (used by the peripheral registers viewer; may be .svd.zip)
[€] C/C++ Attach to Applicatio
[€] C/C++ Container Launcher
[€] C/C++ Postmortem Debug
[€] C/C++ Remote Application
Cif C/C++ Unit
[€] GDB Hardware Debugging

w [E] GDB OpenOCD Debugging

[£] New_configuration

€] GDB PyOCD Debugging
[£] GDB QEMU Debugging

w [c| GDB SEGGER J-Link Debug

| : Project Debus I

F Launch Group

File path: Dy \eclipse-workbase\Nationstech.N32H76x_78x_Library.1.1.0\pr¢  Browse.. Variables...
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7.4 Debug FH

Jlink %4514 %%, Debug Configurations At & 5¢ )5, it Debug,
LB, AT LIRS W T
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N Debug #LK, 85 V1#:3] DEBUG

S eclipse-workbase - Project/USER/main.c - Eclipse IDE = O *
Eile Edit Source Refactor Mavigate Search Project Run Window Help
mild | B D% el EN:® 2|id: 2| SH-0- Q-5 -~
HrF-odero-m Q im| Rt
0. 2 GypPr. T O [g maine 22 [E] main{) at main.c:70 Ox15000460 =0 vz % =0
6 [ §| 3 e v seloe
. | 5 #include "delay. o
v [E] Project Debug [GDB SEC  _ 5o Jide "log.h" g
v 1B Project.elf 58 Name
v o Thread #1 57005 (! 59 woid GPIO_Configuration(void);
= : - 68 woid RCC_Configuration(void);
= main() at main.c 616 -
s JLinkGDBServerCLexe 62
o arm-none-eabi-gdbe B3 program.
. . . G4
) Semihosting and SWA o
13 /
= int main(void)
{
/* Initialize system clock */
RCC_SetSysClkToMode@();
/* RCC configuration ------------mmmmmmmmm e
RCC_Configuration();
/* oG configuration -----------mmmmmm e
log_init();
/* GPI0 configuration -------------c-cmmmeme
GPIO_Configuration();
while (1)
{
88 GPIO SetBits(LED1 PORT,LED1 PIN);
81 systick_delay ms(5@0);
82 GPIO_ResetBits(LED1_PORT,LED1_PIN);
a3 systick_delay ms(500);
84 }
85 }
B Console 2 1l Regist. {2l Proble... {3 Execut.. Gl Debug.. [ Memeory 4 Search = O
"Xk KEREE D
Project Debug [GDB SEGGER J-Link Debugging]
egfper” itize=32 r2" tpui” t/> egs® btize=32 r3" tpflt/> egsl btize=32 r4" tpflt/> ¢
egfper” itize=32 r2" tpui” t/> egs® btize=32 r3" tpflt/: egsl btize=32 r4" tpflt/> ¢
eofrre” i+i7e=22 r2" +nnd" 4% eosh htize=32 r3" +nfl+is  eosl hbizes=32 rd" +nfltis
Writable Smart Insert TO:1:3344
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1) fEREHE TR, Wi EHESACEH Ecipse L. fERBEY, S File->Import , % $
General->Exisiting Projects into Workspace S AN CF L2, siidi“Next”:

Select an import wizard:

= Import = L=
Create new projects from an archive file or directory. [g

pe filter text

IA = General I

I s = CfC++

> = Git

» 2= Install

| » (= Domph

1 > (= RPM

> = Run/Debug

= T |

) Preferences

[ Projects from Folder or Archive

Archive File
|. = Existina Projects into Workspace
! [ File System

13

m

3 -
? = Dack
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2) EFCA TR, Eclipse 2N HIZERIE N HIPTA T2, LA TR, il

“Finish”, EJa] S ABE TIE.

— Import

Import Projects

Select a directory to search for existing Eclipse projects.

[l Search for nested projects
B Copy projects into workspace
[JClose newly imported projects upon completion

[CJHide projects that already exist in the workspace
Working sets

[ Add project to working sets

10 Select root directory: [D:\. . \eclipse-workbase\Nationstech.N32H76x_78x Library.1.0.0\projects\n32h76x_EVAL\examples\GPIO\LedBlink\Eclipse v| Browse...
() Select archive file: Browse...
Projects:
@ Project (D:\LMM'\eclipse-workbase'\Nationstech.N32H76x_78x_Library.1.0.0\projects\n32h76x_EVAL\examples\GPIO\LedBlink\Eclipse) Select All
Deselect All
Refresh
Options

New...

Select...

< Back Next = Cancel
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A

2025/08/18

V1.0.0
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HREARBHERAR CFRR “EHRFAR X SCRHA T 8B K4 e N\ R E 1
VR 2R 2 LA At FHAR 2 R T PR S 1 SR B e rh i 1) L RSB AR 77 i CR R ™ il ™)
NAFFTAE .

RIS IR T LRI FAER B R B SHARAT AT AR A ) o BT B E5] 28
=7 ARREUR I (gD AR A H 1.

B AR B B T IR 338 A8 SO B R SO PIARUR], AN AT . 1 3 ATE
T BRI SE R IR AR ] BB SR IO SO ) BB AR

I R A 8 77 S A HER AT 15 1R BE AR, A BIME bl AN HE R 1 R AT e SCRY HE R 14 A R S
R TIAE

A LSRN A5 2 DA B AR B T, A R A L 2 AT S B BT SR TR L T R AT 2 4
[ R ARAS X ATA] RIS FH s SRS BSOA P i 7= AR (AR A B . ). 4 k. FE ST MEEAT
CREX/IE P 2 €A g
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SRR ST AR E BURIH ST IR
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